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1 Purpose and RRT files 

1.1 Introduction 

This is the manual for the new version from 31 October 2020 of the Reserve Risk Tool (RRT) for 

StandRe. The underlying method has not changed since the prior version. Based on development 

triangles of paid or incurred losses, the RRT allows calculating the best estimate of the reserves 

and the standard deviation of the one-year change in the best estimate reserves (also known as 

the "claims development result") for the three reserving methods:  

• Chain Ladder (CL),  

• Bornhuetter-Ferguson (BF),  

• "Combined Bornhuetter-Ferguson and Chain Ladder" ("Combined BF-CL").  

In StandRe, the Combined BF-CL is the benchmark method for the calculation of the coefficients of 

variation (CV) for the "Attritional Events Reserve Risk" (AER) parameter segments. Results from 

the RRT can be copy-pasted into the SST-StandRe-Template. 

The calculation is implemented in the "StandRe_Reserve_Risk_Tool" spreadsheet with macros, 

which needs to be linked to an Excel add-in (xla-file), which links to the calculation kernel (dll-file), 

as described in Sections 1.2 and 3. Add-in and calculation kernel implement a much more general 

framework for calculating reserve risk called Linear Stochastic Reserving methods1 (LSRM) and 

are part of the package LSRMTools2, a free to use (GNU 3 license) sample implementation of 

LSRM. The three methods considered, specifically the combined BF-CL, are simple special cases 

of the general framework.  

1.2 Files 

The following files are provided for the RRT: 

(1) StandRe_Reserve_Risk_Tool: The RRT-spreadsheet template in Excel with macros, which is 

used to enter data, make manual selections and derive results. 

(2) LSRMTools (version 2.1.2): folder that contains in particular: 

 
1 Dahms, René (2012). Linear stochastic reserving methods. ASTIN Bulletin, Vol. 42, 1–34. An updated version of the paper, called 

"LSRM.pdf", is included within LSRMTools. 

2 LSRMTools.zip (version 2.1.2) was downloaded from https://sourceforge.net/projects/lsrmtools in April 2017. The following legal 
disclaimer holds for using LSRMTools:  

 Bitte beachten Sie bei der Verwendung der Software "LSRMTools" die Hinweise zur Urheberschaft (abrufbar im Dokument "Li-
cense.txt") und die zugehörigen Lizenzbestimmungen (abrufbar im Dokument "COPYING"). Im Übrigen gelten bei der Verwen-
dung der Publikationen zum Schweizer Solvenztest (SST) die Hinweise im Disclaimer zur Nutzung der Webseite der FINMA 
https://www.finma.ch/de/disclaimer/  

 There is a new version from 11 January 2022 of LSRMTools.zip (version 2.1.3) on https://sourceforge.net/projects/lsrmtools. This 
new version has no impact on the StandRe reserve risk tool. For this reason, the FINMA-Website still contains the prior version. 

https://sourceforge.net/projects/lsrmtools
https://www.finma.ch/de/disclaimer/
https://sourceforge.net/projects/lsrmtools
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• LSRMTools\ExcelAddIns\LSRM_Tools_Dll.xla: the Excel add-in. In the 

RRT-spreadsheet, the links need to be set to this file and the add-in needs 

to be declared (explained further below). 

• LSRMTools\bin64\LSRM_Dll.dll and LSRMTools\bin32\LSRM_Dll.dll: contains the func-

tions used for the LSRM. The links in the Excel add-in need to be set to the location of 

these two files (explained further below) 

• LSRMTools\Doc\LSRM.pdf: updated version of the LSRM paper 

• LSRMTools\Doc\LSRMTools.pdf: user manual for LSRM tools 

(3) StandRe_RRT_Manual: this document. 

2 Mathematical background 

2.1 LSRM 

LSRM is the abbreviation for a general framework for calculating reserve risk called Linear Sto-

chastic Reserving methods. Details about LSRM can be found in the updated version of the LSRM 

paper LSRM.pdf (Section 1.2). The LRSM framework is much more general than what is used in 

the RRT.  

Roughly speaking, LSRMs simultaneously consider a collection of 𝑚 = 0,1, … 𝑀 incremental trian-

gles with entries 𝑆𝑖,𝑘
𝑚  (claims paid or claims reported), where 𝑖 = 0,1, … , 𝐼 denotes the accident or 

underwriting year and 𝑘 = 0,1, … , 𝐽 the development year.  

The first basic assumption of LSRMs is that for each triangle 𝑚 there exist exposures 𝑅𝑖,𝑘
𝑚 , which 

are linear functions of the past entries of all triangles, such that the next year’s expected develop-

ment 𝑆𝑖,𝑘+1
𝑚  conditional on the past information is proportional to 𝑅𝑖,𝑘

𝑚 , i.e. 

𝐸[𝑆𝑖,𝑘+1
𝑚 | 𝑝𝑎𝑠𝑡] = 𝑓𝑘

𝑚 ∙ 𝑅𝑖,𝑘
𝑚  

The parameters 𝑓𝑘
𝑚 are called development factors.  

The second basic assumption of LSRMs is that the development of two triangles 𝑚1 and 𝑚2 is cou-

pled via covariance parameters 𝜎𝑘
𝑚1,𝑚2 and exposures 𝑅𝑖,𝑘

𝑚1,𝑚2, i.e. 

𝐶𝑜𝑣[𝑆𝑖,𝑘+1
𝑚1 , 𝑆𝑖,𝑘+1

𝑚2 |𝑝𝑎𝑠𝑡] = 𝜎𝑘
𝑚1,𝑚2 ∙ 𝑅𝑖,𝑘

𝑚1,𝑚2  

where 𝑅𝑖,𝑘
𝑚1,𝑚2 depends on the past of all triangles but not necessarily linearly.  
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The two assumptions look similar to Mack's Chain Ladder assumptions3. Note that 

in the RRT we use slightly different definitions for the development factors than in 

the more general LSRM context, and the covariances from above reduce to vari-

ances/ standard deviations, as explained in Section 2.2. 

The development factors 𝑓𝑘
𝑚 are estimated as a weighted mean of the observed development: 

𝑓𝑘
𝑚 ≔ ∑ 𝑤𝑖,𝑘

𝑚

𝐼−𝑘−1

𝑖=0

𝑆𝑖,𝑘+1
𝑚

𝑅𝑖,𝑘
𝑚  

The "default weights", which provides in some way optimal estimators, are given by: 

𝑤𝑖,𝑘
𝑚 ≔ ( ∑

𝑅ℎ,𝑘
𝑚 𝑅ℎ,𝑘

𝑚

𝑅ℎ,𝑘
𝑚,𝑚

𝐼−𝑘−1

ℎ=0

)

−1

𝑅𝑖,𝑘
𝑚 𝑅𝑖,𝑘

𝑚

𝑅𝑖,𝑘
𝑚,𝑚  

The covariance parameters are estimated by: 

𝜎̂𝑘
𝑚1,𝑚2 ≔

1

𝑍𝑘
𝑚1,𝑚2

∑
𝑤𝑖,𝑘

𝑚1𝑤𝑖,𝑘
𝑚2

𝑅𝑖,𝑘
𝑚1,𝑚2

𝐼−𝑘−1

𝑖=0

(
𝑆𝑖,𝑘+1

𝑚1

𝑅𝑖,𝑘
𝑚1

− 𝑓𝑘
𝑚1) (

𝑆𝑖,𝑘+1
𝑚2

𝑅𝑖,𝑘
𝑚2

− 𝑓𝑘
𝑚2) 

where 𝑍𝑘
𝑚1,𝑚2 are normalizing constants that lead to unbiased estimators. 

With these assumptions and estimators, the paper LSRM.pdf (Section 1.2) derives general formu-

las for calculating the standard deviation of the one-year change in the best estimate reserves (also 

known as "claims development result"). These formulas are used in the RRT for the special cases 

of LSRMs described in Section 2.2. 

2.2 Chain-Ladder, Bornhuetter-Ferguson, Combined BF-CL 

2.2.1 Chain Ladder  

The Chain Ladder model introduced by Mack4 is based on two assumptions that can be formulated 

in terms of LSRMs. For the LSRM formulation, only one triangle is used, where we use the com-

mon formulation in terms of cumulative triangles with entries 𝐶𝑖,𝑘 instead of incremental triangles 

𝑆𝑖,𝑘, i.e. 

𝐶𝑖,𝑘+1 = 𝐶𝑖,𝑘 + 𝑆𝑖,𝑘+1 

The first assumption is that there exist development factors 𝑓𝑘
𝐶𝐿 such that  

 
3 Mack, Thomas (1993). Distribution-free calculation of the standard error of chain ladder reserve estimates. ASTIN Bulletin, Vol. 

23/2, 213–225. 

4 Mack, Thomas (1993). Distribution-free calculation of the standard error of chain ladder reserve estimates. ASTIN Bulletin, Vol. 
23/2, 213–225. 
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𝐸[𝐶𝑖,𝑘+1|𝑝𝑎𝑠𝑡] = 𝑓𝑘
𝐶𝐿 ∙ 𝐶𝑖,𝑘 

In the LSRM notation, we have  

𝑓𝑘
𝐶𝐿 = 1 + 𝑓𝑘

𝐶𝐿,𝐿𝑆𝑅𝑀
 

for the equivalent LSRM condition 

𝐸[𝑆𝑖,𝑘+1|𝑝𝑎𝑠𝑡] = 𝑓𝑘
𝐶𝐿,𝐿𝑆𝑅𝑀 ∙ 𝑅𝑖,𝑘 

where the "exposures" 𝑅𝑖,𝑘 = 𝐶𝑖,𝑘 are given by the cumulative triangle 𝐶𝑖,𝑘. The corresponding as-

sumption on the variance is 

𝑉𝑎𝑟[𝐶𝑖,𝑘+1|𝑝𝑎𝑠𝑡] = 𝑉𝑎𝑟[𝑆𝑖,𝑘+1|𝑝𝑎𝑠𝑡] = (𝜎𝑘
𝐶𝐿)2 ∙ 𝐶𝑖,𝑘 = (𝜎𝑘

𝐶𝐿)2 ∙ 𝑅𝑖,𝑘 

Note that we must have 𝐶𝑖,𝑘 ≥ 0 as the variance cannot be negative 

The "individual observed development factors" 𝑓𝑘
𝐶𝐿,𝑜𝑏𝑠,𝑖

 for accident or underwriting year 𝑖 from de-

velopment year 𝑘 to 𝑘 + 1 are   

𝑓𝑘
𝐶𝐿,𝑜𝑏𝑠,𝑖 =

𝐶𝑖,𝑘+1

𝐶𝑖,𝑘

= 1 +
𝑆𝑖,𝑘+1

𝑅𝑖,𝑘

= 1 + 𝑓𝑘
𝐶𝐿,𝐿𝑆𝑅𝑀,𝑜𝑏𝑠,𝑖

 

In the RRT, the Chain Ladder development factors 𝑓𝑘
𝐶𝐿 are displayed as real numbers around 1.00.  

2.2.2 Bornhuetter-Ferguson  

Here we use (in line with the LSRM) the Bornhuetter-Ferguson (BF) model of Mack5 (in contrast to 

the alternative version in which the development pattern is derived by Chain Ladder). In terms of 

LSRMs, we have two triangles, the incremental paid or incurred claims development triangle with 

entries 𝑆𝑖,𝑘 = 𝑆𝑖,𝑘
0  and an additional auxiliary triangle 𝑆𝑖,𝑘

1 = 1{𝑘=0} ∙ 𝑈𝑖
𝑝𝑟𝑖

. Here, 𝑈𝑖
𝑝𝑟𝑖

 is the a priori ulti-

mate for year 𝑖, i.e. the initial estimate for the total losses to the accident or underwriting year 𝑖. We 

require 𝑈𝑖
𝑝𝑟𝑖

≥ 0. 

In this model, the first assumption is that there exist development factors 𝑓𝑘
𝐵𝐹 (same definition in 

LSRM) such that 

𝐸[𝑆𝑖,𝑘+1|𝑝𝑎𝑠𝑡] = 𝑓𝑘
𝐵𝐹 ∙ 𝑈𝑖

𝑝𝑟𝑖
= 𝑓𝑘

𝐵𝐹 ∙ 𝑅𝑖,𝑘 

So the "exposure" 𝑅𝑖,𝑘 = 𝑆𝑖,0
1 = 𝑈𝑖

𝑝𝑟𝑖
 is the a priori ultimate for year 𝑖. The above assumption means 

that, independently of the past realizations, the next incremental paid or reported claims amount is 

expected to be given by a ratio 𝑓𝑘
𝐵𝐹 of the a priori ultimate. The 𝑓𝑘

𝐵𝐹 can thus be thought to repre-

sent an incremental "development pattern". For this reason, the factors are displayed in the RRT as 

percentages, e.g. 15.7%. 

 
5 Mack, Thomas (2008). The prediction error for Bornhuetter-Ferguson. ASTIN Bulletin. Vol. 38, 87–103. 
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The corresponding assumption on the variance is 

𝑉𝑎𝑟[𝐶𝑖,𝑘+1|𝑝𝑎𝑠𝑡] = 𝑉𝑎𝑟[𝑆𝑖,𝑘+1|𝑝𝑎𝑠𝑡] = (𝜎𝑘
𝐵𝐹)2 ∙ 𝑈𝑖

𝑝𝑟𝑖
= (𝜎𝑘

𝐵𝐹)2 ∙ 𝑅𝑖,𝑘 

The "individual observed development factors" 𝑓𝑘
𝐵𝐹,𝑜𝑏𝑠,𝑖

 for accident or underwriting year 𝑖 from de-

velopment year 𝑘 to 𝑘 + 1 are   

𝑓𝑘
𝐵𝐹,𝑜𝑏𝑠,𝑖 =

𝑆𝑖,𝑘+1

𝑈𝑖
𝑝𝑟𝑖

=
𝐶𝑖,𝑘+1 − 𝐶𝑖,𝑘

𝑈𝑖
𝑝𝑟𝑖

=
𝑆𝑖,𝑘+1

𝑅𝑖,𝑘

 

The development factors thus correspond to the percentage of the a priori ultimate that is incre-

mentally paid or incurred in the corresponding development period.  

2.2.3 Combined BF-CL  

For the combined BF-CL, the development factors are assumed equal to  

• the BF development factors 𝑓𝑘
𝐵𝐹 for the first development periods 𝑘 = 0,1, … , 𝑘0 − 1, with the 

a priori ultimates 𝑈𝑖
𝑝𝑟𝑖

 as exposures; 

• equal to the CL development factors 𝑓𝑘
𝐶𝐿 for the later development periods 𝑘 = 𝑘0, 𝑘0 +

1, … , 𝐽, with the cumulative (paid or incurred) losses 𝐶𝑖,𝑘 as exposures. 

Here, 

• 𝑘0 = number of years for the Bornhuetter-Ferguson method (Section 4.4)  

In the RRT, the BF and CL development factors are displayed as percentages and real numbers 

around 1.00, respectively. 

3 Setting up the RRT 

3.1 Set up 

See Section 1.2 for the files provided for the RRT. The files relevant for the setup are the RRT 

spreadsheet StandRe_Reserve_Risk_Tool and the folder LSRMTools. For the time being, it is ex-

pected that FINMA will not change contents of the folder LSRMTools.  

In principle, the folder LSRMTools and the spreadsheet StandRe_Reserve_Risk_Tool can be 

saved to any location. However, it might work best if the local C drive is used, e.g. a subfolder of 

the desktop, specifically for the folder LSRMTools. 
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Subsequently, the setup consists of the following steps, which are explained in 

more detail below. Only step (a) is needed if the folder LSRMTools is already in-

stalled and set up (i.e. steps (b) and (c) have been done previously): 

(a) Set the links in the spreadsheet StandRe_Reserve_Risk_Tool.xlsm to the location of the Excel 

add-in LSRM_Tools_Dll.xla (Section 1.2) within the folder LSRMTools. This step is specific to 

the spreadsheet and the location of LSRM_Tools_Dll.xla.  

(b) In the Excel add-in overview (File → Options → Add-ins), declare in the Excel add-in 

LSRM_Tools_Dll.xla at the correct location of the file LSRM_Tools_Dll.xla (Section 1.2). This 

step is independent of the spreadsheet and depends on the location of LSRM_Tools_Dll.xla.  

(c) In the Excel add-in LSRM_Tools_Dll.xla (which is displayed as LSRM_Tools_Dll in the VBA 

part of Excel, Alt + F11), in the code of the DLLFunction_Declaration module, set the correct 

path to the folder LSRMTools for the functions that are used by LSRM_Tools_Dll.xla. This step 

is independent of the spreadsheet and depends on the location of the folder LSRMTools (as-

suming the order within this folder has not changed).  

3.2 Detailed steps 

To achieve the above, perform the following steps in sequence: 

For (a): 

(1) Open the spreadsheet StandRe_Reserve_Risk_Tool.xlsm, ignore messages, do not update 

links. 

(2) In the header,  

• go to Data → Edit Links → select "LSRM_Tools_Dll.xla"  

• select "Change source" ("Quelle ändern") → select the applicable location of the file 

LSRM_Tools_Dll.xla. → press "OK" → press "Close" 

For (b):  

(1) Go to File → Options → Add-ins → Go → select "LSRM_Tools_Dll.xla"  

• delete or remove tick mark (or do nothing if "LSRM_Tools_Dll.xla" does not appear) → 

close 

• save the spreadsheet StandRe_Reserve_Risk_Tool.xlsm & close it 

(2) Open the spreadsheet StandRe_Reserve_Risk_Tool.xlsm, ignore messages,  

• go to File → Options → Add-ins → Go → select "LSRM_Tools_Dll.xla" → set tick mark (or 

do nothing if "LSRM_Tools_Dll.xla" does not appear)  
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• "Browse" → go to applicable location of the file LSRM_Tools_Dll.xla.  

• If there is a message about whether to "copy", deny the request. If the 

message is about "overwriting", accept the request. 

• select "LSRM_Tools_Dll.xla" by setting the tick mark 

For (c): 

(1) In the spreadsheet StandRe_Reserve_Risk_Tool.xlsm,  

• open VBA (e.g. Alt + F11) → go to the project "LSRM tools DLL (LSRM_Tools_Dll.xla)" → 

go to "Modules" → open the module "DLLFunction_Declaration" by double clicking  

• replace the path of the folder "LSRM_Tools" that is in the code with the applicable path (in 

the header, go to Edit → Replace, put the existing path in "Find What:" and the applicable 

path in "Replace With:" and click Replace all); this should make 193 replacements  

• run the sub "Save XLA" at the bottom of the code of the module "DLLFunction_Declara-

tion". E.g. by selecting the three lines of the sub and clicking "⊳" ("Run sub/Userform").  

• close VBA  

(2) Potentially: save the spreadsheet StandRe_Reserve_Risk_Tool.xlsm and close it → open 

the spreadsheet StandRe_Reserve_Risk_Tool.xlsm 

3.3 Trouble shooting 

• Some cells display "LSRM not found": the installation should have worked, now you need 

to calculate. 

• Some cells display ""#NAME": set the links in the spreadsheet to  LSRM_Tools_Dll.xla by 

"For (a)" in Section 3.2. If this works, you will see "LSRM not found" in some cells and you 

might see "#VALUE!" on some cells. If it does not work, do "For (b)" and "For (c)" from 

Section 3.2. 

• Some cells display "#VALUE!": this can be a common calculation error. Otherwise, you 

might have to do "For (b)" and "For (c)" from Section 3.2. 

• If after starting Excel, the following message is shown, then it is easiest to change regional 

settings of your Windows to "English (UK)" or "German (Switzerland)". 
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4 RRT calculation 

4.1 Overview 

In the following, we explain the steps for an RRT calculation, going through and explaining the rele-

vant sheets of the StandRe_Reserve_Risk_Tool spreadsheet. Prior to this step, the spreadsheet 

needs to be linked to the LSRMTools package as explained in Section 3. 

After calculation and analysis, when results are final, prior to submitting results to FINMA, make 

sure that in the sheet "Results" (Section 4.4) you press the button "Calculate and copy-paste input 

& results" (Section 4.4.3) so that the final results are copied. Then press the button "Save Excel as 

xlsx" (Section 4.4.5), which automatically produces an "xlsx" version of the spreadsheet, i.e. with-

out macros, to be submitted to FINMA.  

See Section 4.7 for a detailed illustration of the workflow. 

4.2 Sheet "Intro_RRT" 

Some general information to fill out and explanations of the color-coding. In the following, we con-

centrate on the light blue sheets. 

4.3 Sheet "Input" 

4.3.1 Input data 

The main sheet to enter input data. Under "General information", specifications on the data ana-

lyzed are provided. All fields should be filled out correctly, as information is used elsewhere. In par-

ticular: 

(a) "Input triangle incremental or cumulative?": development triangle data can be either incremen-

tal or cumulative. The selection here needs to be consistent with the actual form of the triangle 

data entered. 
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(b) Currency information and exchange rate: the information entered here is used 

to convert to SST currency so that the data then can be copy-pasted into the 

SST-StandRe-Template. Please use the three-digit name, e.g. "CHF". The ex-

change rate is the defined as the amount in SST currency for one unit of the parameter seg-

ment currency.  

(c) "Most recent reported year", "First reported year": this information is used to define the range 

of accident or underwriting years for which the calculation should be performed and the dimen-

sions of the development triangle considered. The most recent reported year is typically the 

most recent prior year. 

Below this is the input data for the calculation: 

(d) "A priori ultimates": vector of the a priori, i.e. initial best estimates of the total losses per acci-

dent or underwriting year. Used for BF and combined BF-CL. 

(e) "Most recent cumulative payments": the most recent cumulative loss payments per accident or 

underwriting year, i.e. the non-discounted sum of the loss payments for that year up to and 

including the "most recent reported year" 

(f) Claims development triangle, as applicable and selected under "general information", either of 

paid or incurred losses, per accident or underwriting year, and incremental or cumulative.  

4.3.2 Comparison of input data 

Below the input data, the a priori ultimates and the claims development triangle are compared to 

the corresponding data that is stored in the sheet "Copy of input & selections", see Section 4.6. A 

cell in the comparison range is blank if the corresponding cells are identical. An "xxx" indicates that 

the cell in the sheet "Copy of input & selections" is non-blank and non-zero, but the corresponding 

cell in the sheet "Input" is blank or zero. Otherwise, the percentage difference between the cell in 

the sheet "Copy of input & selections" and the corresponding cell in the sheet "Input" is displayed. 

Assume that the RRT spreadsheet has been filled out in the previous year and the input data and 

the selection have then been copy-pasted into the sheet "Copy of input & selections" using the but-

ton "Calculate and copy-paste input & results" (Section 4.4.3). Then this provides a comparison of 

the new data entered for the current year with the data entered the previous year.  

4.4 Sheet "Results" 

4.4.1 Input and general 

The sheet "Results" contains the buttons for performing the calculations and the overview of the 

results.  

(a) "Number of years for the Bornhuetter-Ferguson method": this is the required input to specify 

the combined BF-CL method (Section 2.2). 
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(b) "Use manual adjustments (if available)": this field is "TRUE" by default and 

then implies that the user-made manual selections are used if there are such 

selections, and otherwise the default parameters are used. If the field is set to 

"FALSE", only default parameters are used, even if there are manual selections. 

(c) "Default add-on (for uncertainty on a priori ultimates)": this field is intended to capture the un-

certainty in the a priori ultimates and is by default set to 105%.  

(d) "Indicator that input has changed and recalc may be necessary": if this field shows "TRUE" in 

red color, this is an indication that a recalculation may be necessary due to input changes. 

(e) "Time stamp of calculation": calculation results are assigned a "time stamp" of the date and 

time the calculation is produced. (This is also used as the name of the instance of the object in 

the "LSRM class" and is used to identify that instance.) 

(f) "Output to SST-StandRe-Template": this is an output form of the required output for the SST-

StandRe-Template. Amounts are converted to SST currency where necessary.  

Results of a specific calculation are displayed in the main part of the sheet for the three methods 

combined BF-CL, CL and BF, also separately for the different accident or underwriting years.  

Calculations can be run either by pressing the button "with copy-paste" explained in Section 4.4.3 

or the button "without copy-paste" explained in Section 4.4.4. With the former, the results are cop-

ied and pasted as values to the area to the right (as cells with the "pointy" pattern). This ensures 

that the calculation results are retained without recalculation also when closing the spreadsheet (or 

saving it as "xlsx", Section 4.4.5). 

4.4.2 Button "Save spreadsheet as" 

Pressing this button to "save as" the spreadsheet opens a message box with a proposed name 

given by the spreadsheet name followed by the one plus the "most recent reported year" (Section 

4.3) and the parameter segment name (from "general information" in the sheet "Input"). The pro-

posed name can be changed. The spreadsheet is saved with the selected name as a macro-ena-

bled spreadsheet (".xlsm"). 

4.4.3 Button "Calculate and copy-paste input & results" 

Pressing this button runs the calculation and copy-pastes the calculation results as values and with 

the formatting to the area to the right (as cells with "pointy" pattern). Further, the inputs (from the 

sheet "Input", Section 4.3) and the manual selections (from the sheets "Combined BF-CL", "Chain-

Ladder", "Bornhuetter-Ferguson", Section 4.5) are copy-pasted as values with formatting into the 
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sheet "Copy of inputs & selections" (Section 4.6). This preserves these results and 

should thus be done in particular when the calculation is final.6 

4.4.4 Button "Calculate without copy-paste (to compare)" 

Pressing this button runs the calculation (as in Section 4.4.3) but does not copy-paste anything. 

This can for example be used to compare the results of one calculation with the results from the 

preceding calculation, provided the latter have previously been copy-pasted to the area to the right. 

4.4.5 Button "Save Excel as xlsx" 

Pressing this button produces an "xlsx" version of the spreadsheet, i.e. without macros, in the form 

that can be uploaded to the FINMA platform. Note that this does not delete macros, buttons etc. 

4.5 Sheets "Combined BF-CL", "Chain-Ladder", "Bornhuetter-Ferguson" 

These are the analysis sheets for the three methods combined BF-CL, CL and BF. Note that these 

sheets are only completely filled out once a calculate button in the sheet "Results" has been 

pressed (Section 4.4), so this needs to be done before analyzing these sheets.  

Triangles and weights 

The structure of each sheet is the same. It starts with the cumulative triangle corresponding to the 

data from the sheet "Input", followed by the triangle of the individual observed development factors 

calculated according to the method (BF or CL) for the corresponding development year (Section 

2.2). Factors calculated by BF are displayed as percentages and factors calculated by CL as dou-

ble. 

The next triangle allows excluding individual observed development factors by setting the corre-

sponding weight to zero (by default, all weights are equal to one).  

Model parameters and tail factor 

The rows below the weights triangle show the resulting parameters of the model (Section 2.2):  

(a) development factors per development year (as applicable BF or CL); 

(b)  standard deviation parameters. 

 
6 Technically, pressing the button runs a VBA macro (Alt + F11, "Modul1", "Sub ReCalcAndCopyPaste()") which in particular runs 

the LSRM subroutine "LSRMInit" three times (because of cell formulas that refer to cells that are an output of the LSRM calcula-
tion). This produces an instance of the "LSRM class" whose identifier is the time stamp of the calculation (Section 3.3).  All calcula-
tion results are functions on this object that are formulas starting with "LSRM" in the relevant cells. 
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The parameters that are estimated directly from the triangle are shown in light col-

ors. The parameters to be used for the tail are dynamically shown in darker colors 

under the heading "tail". The subsequent parameters in the darkest colors should 

not be entered manually (the parameters shown there do not impact the result).7 

The parameters are shown with and without manual weight selections. Manual parameter selec-

tions can be made (where justified) in the row headed "manual". Especially when input triangles 

are too short to capture to full development, a tail development factor (and uncertainty) should be 

selected. Any tail development and uncertainty should go into the development period headed by 

"tail". Please do not enter numbers for the later development periods. The row headed "selected" 

shows the final selection, which is equal to the manual selection if the corresponding cell is non-

empty and otherwise equal to the default (with manual exclusions).  

The row for the standard deviations headed "normalized (to dev factors)" shows a rough approxi-

mation that could give an indication of the modeled standard deviation (implied by the selected 

standard deviation parameters) of the individual observed development factors around the esti-

mated development factors.8 

Completed triangle 

Below the model parameters, the (cumulative) claims triangle is completed using the selected de-

velopment factors to predict the claims development not yet known.   

Everything below the completed triangle, separated by a colored row, is auxiliary data used for the 

calculation that in most cases does not need to be reviewed. 

4.6 Sheet "Copy of input & selections" 

This sheet contains copies (as values with formatting) of the input data from the sheet "Input" (Sec-

tion 4.3) and the selections from the sheets "combined BF-CL", "Chain-Ladder" and "Bornhuetter-

Ferguson" (Section 4.5). From the latter it contains the "selected weights" triangle and the parame-

ters (development factors and standard deviation parameters). The copies are produced when the 

button "Calculate and copy-paste input & results" is pressed (Section 4.4.3).  

The previous input data (explicitly, a priori ultimates and claims development triangle, Section 4.3) 

that have previously been copied into this sheet is compared in the sheet "Input" (Section 4.3) with 

the current input data.   

4.7 Workflow illustration 

After the RRT is set up as explained in Section 3: 

 
7 Results using a tail factor may be slightly different from the results pre 31 October 2020. 

8 The mathematical assumptions of the methods do not allow a precise interpretation of the standard deviation parameters in these 
terms. 
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(1) Enter the required information in the sheets "Intro_RRT" (Section 4.2) and 

"Input" (Section 4.3). 

(2) In the sheet "Results", press the button "Save spreadsheet as" (Section 4.4.2) to produce a 

version of the RRT for the year of analysis and the parameter segment considered. 

(3) In the sheet "Results", select "Number of years for the Bornhuetter-Ferguson method", 

then press the button "Calculate and copy-paste input & results" (Section 4.4.3). 

(4) Analyze data and results in the sheets "combined BF-CL", "Chain-Ladder" and "Bornhuet-

ter-Ferguson" (Section 4.5) and make manual selection where required and justified, in-

cluding tail factors. 

(5) In the sheet "Results", where appropriate, change "Number of years for the Bornhuetter-

Ferguson method", then press the button "Calculate without copy-paste (to compare)" 

(Section 4.4.4). Compare the results with the new selections to the results from the first 

calculation. 

(6) If the results are final, press the button "Calculate and copy-paste input & results" (Section 

4.4.3) in the sheet "Results". This ensures that input data, selections and results are re-

tained. 

(7) Copy-paste the results from "Output to SST-StandRe-Template" (Section 4.4.1) in the 

sheet "Results" to the SST-StandRe-Template. 

(8) In the sheet "Results", press the button "Save Excel as xlsx" (Section 4.4.5) to produce a 

macro-free spreadsheet version to be submitted to FINMA. 

"One year later": 

(9) Open the xlsm-version of the RRT spreadsheet for the parameter segment from the previ-

ous year. 

(10) Enter the required information in the sheets "Intro_RRT" (Section 4.2) and "Input" (Section 

4.3). 

(11) In the sheet "Input" (Section 4.3), compare the input data with the input from the previous 

year (from the sheet "") to check consistency. 

(12) In the sheet "Results", press the button "Save spreadsheet as" (Section 4.4.2) to produce a 

version of the RRT for the new year of analysis and the parameter segment considered. 

(13) In the sheet "Results", select "Number of years for the Bornhuetter-Ferguson method", 

then press the button "Calculate without copy-paste (to compare)" (Section 4.4.4). 

(14) Compare the results for the current year to the results from the previous year. Etc. 
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4.8 Other sheets 

4.8.1 Sheet "LSRM model parameter" 

This sheet specifies the three methods "combined BF-CL", CL and BF in the general framework of 

LSRM.  

4.8.2 Sheet "Covariance parameters" 

This sheet contains the covariance parameters relevant for the general LSRM framework. 


